AN2321
Solar MPPT Battery Charger for the Rural Electrification System

INTRODUCTION

Solar chargers are increasingly gaining momentum with government agencies pushing towards a greener solution through the use of energy derived from renewable sources. A solar charger mainly functions on the principle of harnessing the energy from the sun and utilizing it to supply electrical energy to devices or for charging batteries. Although the solar charger industry has been plagued by many companies manufacturing solar chargers, most of these are based on the concept of traditional grid infrastructure with permanently installed units. Very few have ventured into portable solar units. Such portable solar units become very handy when it comes to distributed energy solutions, especially in developing countries. Portable solar power provides an opportunity for rural areas in developing countries to skip the traditional grid infrastructure and move directly to distributed solutions. For off-peak usage during the night, battery banks can be used to store energy. In addition, during the day these solar chargers can supplement the main power supply, thereby yielding better energy savings.

This application note is aimed at approaching such a rural market by providing a solution in the form of a portable solar charging system. The details of the hardware design, manipulation of the power stages, implementation of Maximum Power Point Tracking (MPPT) and battery management will be the key highlights covered in this application note. It also covers explanation of the design of compensators for the various power converters using a PIC® microcontroller with its superior class of Core Independent Peripherals (CIPs).

SYSTEM SPECIFICATIONS

Power Budget

<table>
<thead>
<tr>
<th>System</th>
<th>Power</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solar panel</td>
<td>130W in full sun</td>
<td>Provide system with 1.3 kWh charge in 10 hours</td>
</tr>
<tr>
<td>Battery</td>
<td>Two 12V@55Ah</td>
<td>Storage capacity for 1.3 kWh of charge</td>
</tr>
<tr>
<td>Lighting</td>
<td>2x5W@6hrs</td>
<td>60 Wh (assumes 6 hours of light)</td>
</tr>
<tr>
<td>12V@2A</td>
<td>24W</td>
<td>576 Wh (assumes 24-hour usage)</td>
</tr>
</tbody>
</table>

Endurance

A fully charged system can operate for two days at maximum load without charging.

The system can operate lights for three weeks on a single 10-hour charge, not including a 12V charging load.

Charge Distribution within the System

1. During sunlight, the system will efficiently transfer the maximum power from the solar panel to the load, with any extra charge routed to the battery for charging.
2. If the battery is fully charged, then excess charge is left in the solar panel.
3. In marginal sunlight, power from the solar panel can be augmented by power from the battery.
4. Without sunlight, the load will be efficiently powered from the battery.

The system will also include a fail-safe system to prevent damage in the event of incorrect connection to the solar panel, battery or loads. The system will send status and alarm conditions via a low-power Bluetooth® interface compatible with laptop and cell phones.
BASIC PRINCIPLE

The voltage current and power produced by a solar panel are highly variable in response to ambient conditions and dramatically dependent on the electrical impedance of the imposed load (V vs. I). Under any combination of ambient conditions, it is characterized by exactly one ideal load impedance, which will result in operation at VMPPT and maximum power transfer.

Maximum Power Point Tracking (MPPT) is an electronic system that operates the solar photovoltaic (PV) modules in a manner that allows them to produce the maximum power they are capable of. MPPT is different from a mechanical tracking system (panel tracking) that physically "moves" the modules to make them point directly at the sun. Maximum Power Point Tracking is electronic tracking, usually digital. The MPPT controller checks the variable load requirements and panel output at any instant. It then simulates the load conditions to get maximum power from the panel using digital techniques. MPPT changes the current or voltage output to load to simulate ideal load conditions for maximum power from the panel. Most modern MPPTs are around 93-97% efficient in the conversion. They deliver a 20-45% power gain in winter and 10-15% in summer. Actual gain can vary widely depending on weather, temperature, battery state of charge, and other factors. The MPPT controller will harvest more power from the solar array. The performance advantage is substantial (10-40%) when the solar cell temperature is low (below 45°C), or very high (above 75°C), or when irradiance is very low.

A typical solar panel power graph (Figure 1) shows the open circuit voltage to the right of the maximum power point. The open circuit voltage (VOC) is the maximum voltage that the panel outputs, because no power is being drawn from the circuit. The short circuit current of the panel (ISC) is another important parameter, because it is the absolute maximum current that can be received from the panel.

The maximum amount of power that can be extracted from a panel depends on three important factors: irradiance, temperature and load.

Figure 1 shows the effect of different irradiance levels on the panel voltage, current and power. Irradiance mainly changes the panel operating current. Temperature changes the panel voltage operating point. To match the ideal panel impedance to load impedance, a DC-DC converter is used. For example, a 5V/2A (i.e., 10W) load is supplied from a 20W PV panel with MPP at 17.5V/1.15A. The panel short circuit current is 1.25A. If the load is connected directly to the panel, then it will provide 5V*1.15A = 5.75W max to load and not 10W. Thus, the panel will not operate at MPP. A DC-DC converter can be used to variably change the load conditions with varying duty cycle to modify load voltage or current seen from the panel to track MPP.

Since solar MPPT controllers are installed on remote fields, and sometimes, on remote locations, special considerations should be taken when designing the system. One suggestion would be to design the system as a single module potted in plastic. Doing this would provide protection against dust, water and help with moisture resistance. Another suggestion would be to add heat sinks for passive air cooling. This would help increase the longevity of the parts and boards. The system should be designed as such that even if the connections are wired incorrectly, the unit should not get damaged.

FIGURE 1: SOLAR PANEL CHARACTERISTICS
There are several MPPT algorithms that can be easily implemented using an 8-bit PIC® microcontroller:

1. Perturb and Observe (P&O): As the name suggests, the current or voltage output of MPPT DC-DC converter is increased or decreased in linear steps to alter its normal or regular state. If there is an increase in power output from the panel, increase perturbation further to see if output power increases again. If output power is less, reduce the perturbed output by linear steps. This process of perturbation and observation slowly reaches to MPP of the panel. The algorithm is very simple in terms of implementation. However, there are a few disadvantages to this type of system, such as the inherent steady-state oscillations at the Maximum Power Point (MPP), if the linear step size is too large. Also, if the step size is too small or the system takes too long to respond to perturbation, it will take a longer time to reach MPP.

2. Incremental Conductance: In this algorithm, the current or voltage output from MPPT DC-DC converter is incremented or decremented in linear or nonlinear steps. But instead of the output power being measured, the ratio of power difference to voltage difference (i.e., dP/dV), is used to determine the MPP. As shown in Figure 1, dP/dV is a typical MPP curve provided by a panel manufacturer. If the ratio is negative, the MPP is on the left, and so panel current I, or panel voltage V, should be reduced. If the ratio is positive, the MPP is on the right and the panel current I, or panel voltage V, should be increased. If the ratio is zero, the controller has reached MPP. The algorithm is a bit complex for implementation compared to P&O. If the step size is linear, the algorithm exhibits steady-state oscillations at MPP. But this can be solved with nonlinear step size. The value of step size can be changed with respect to dP/dV output. The ratio output can also be used in a PID controller as error value. Then the oscillations can be filtered out, and the system also responds quickly to change in MPP with respect to atmospheric changes.

For details about the algorithms, refer to the application note AN1521, “Practical Guide to Implementing Solar Panel MPPT Algorithms” (DS00001521).

FIGURE 2: SOLAR MPPT BATTERY CHARGER BLOCK DIAGRAM
SOLAR PANELS

130W/12V solar panels used in the system are readily available on the market. A list of solar panel manufacturers is provided in Appendix D: “Solar Panel Manufacturers”.

MPPT DC-DC BOOST CONVERTER

The panel voltage will be in the range of 15V-22V. This will be stepped up to 26.8V using a boost converter to charge the 24V battery. The PIC microcontroller generates the necessary control signals to drive the DC-DC boost converter that converts the solar panel power to charge the battery and to supply the load. Peak current-mode controlled (PCMC) DC-DC boost converter is used. The peripherals used are 10-bit PWM, COG, op amp, comparators, DAC, PRG, and FVR to generate the PWM signals for the DC-DC boost converter. The MPPT is implemented using a comparator with DAC reference. The value of DAC is controlled using the MPPT algorithm explained above. For details about the implementation of PCMC DC-DC boost converter, refer to Section “PCMC DC-DC Boost Converter with MPPT”.

Battery

The design uses two 12V, 55 AHr deep-cycle sealed lead acid (SLA) marine batteries connected in series to make a 24V battery. These batteries are typically used for boats and marine applications to handle deep discharge. Most car batteries can do high starting current, but are only designed for 10-20% discharge, and their lifetime suffers if it is discharged deeper than that. The other advantage marine batteries have is that they are typically sealed, therefore the user does not have to worry about acid leakage. The big advantage of a deep-cycle lead acid battery is that it can be charged from a constant voltage source with whatever current is received from the solar panel. This means there is no need for separate switchers for the MPPT and battery charging, as only one with a constant output voltage and variable current can be used. If multiple batteries are connected in series, a charge balancing is required as explained in Section “Battery Charging and Charge Balancing” below. While deep-cycle batteries are preferable, normal car and tractor batteries can be used with the system. This will be able to detect and prevent damage if the batteries are connected incorrectly or in reverse direction.

System Load

Three DC-DC buck converters are used for generating the 12V output going to the two LED bulbs and mobile electronic charger load. The DC-DC buck converters are controlled using on-chip op amp, DSM, DAC, PRG, comparator, 10- and 16-bit PWM and COG peripherals of the PIC microcontroller.

LED Bulbs

There is a provision to connect two 12V/5W LEDs that are powered by one of two different types of drivers. LED driver outputs may be constant voltage (usually 12 V or 24 V) or constant current (e.g., 350 mA, 700 mA or 1050 mA). This system has an output of constant voltage 12V.

LED DIMMING

Constant voltage LED drivers can be dimmed via a PWM method.

The dimming engine for the two LED bulbs is implemented using on-chip op amp, comparator, PRG, 16-bit PWM, CCP, DAC, DSM and COG peripherals of the PIC microcontroller.

The dimming of the LED bulbs is implemented using two switch buttons. Depending upon the dimming level the duty cycle of the PWM going to the LED can be adjusted. For details about the LED dimming engine implementation, refer to Section “LED Dimming Engine”.

Current consumed by the LED bulbs is sensed by a comparator. In case of short circuit or current exceeding 500 mA, the comparator output will go high and, since it is connected to the auto-shutdown pin of the COG, this will cut the 12V power going to the LED.

12 Vdc POWER FOR CHARGING OF MOBILE ELECTRONICS

The system will provide a 12V, 2A output for driving a standard automobile cigarette lighter socket.

Current consumed by the load will be sensed by a comparator. In case of short circuit or current exceeding 2A, the comparator output will be triggered. The comparator output is connected to the auto-shutdown pin of the COG. This will cut the 12V power going to the load.

TOTAL SYSTEM LOAD

For six hours of light per day, two 5W LEDs will consume 2x5W @ 6hrs = 60 WH.

The 12V output at 2A will require 24Wx24 = 576 WH, assuming a 24-hour usage.

The fully charged system can operate for two days at maximum load without charging.
The system can operate lights for three weeks on a single 10-hour charge if 12V charging output is not used.

Load Regulation

The output of DC-DC buck converter is connected to different loads, which is controlled or regulated by the microcontroller. There are different types of load used, LED lamps, small chargers.

If the battery is deep discharged and needs recharged, the loads can be switched off and all current goes to the battery, making it charge faster. If the battery is fully charged, most of the power goes to different loads and the battery charging is off. This load regulation is done in the MCU using PWM control.

HARDWARE DESIGN CONSIDERATIONS

PIC16F1779 Advantages and Features

PIC16F1779 is an 8-bit PIC microcontroller that combines the processing power of CIPs and intelligent analog peripherals with a functionality of a microcontroller on a single chip to create a cost-effective solution. PIC16F1779 includes many peripherals that are especially useful for switch mode power supply, power management, and medical monitoring applications.

PIC16F1779 provides the following peripherals:
- Fixed Voltage Reference (FVR)
- 10-bit Analog-to-Digital Converter (ADC)
- 5-bit Digital-to-Analog Converter (DAC)
- 10-bit Digital-to-Analog Converter (DAC)
- Op amp
- Programmable Ramp Generator (PRG)
- High-Speed Comparator: High-Speed Comparator modules which can use 5-bit/10-bit DAC references for comparing two analog input voltages. The comparator is designed to operate across the full range of the supply voltage (rail-to-rail operation).
- 10-bit Pulse-Width Modulation module (PWM)
- 16-bit Pulse-Width Modulation module (PWM)
- Complementary Output Generator (COG)
- Zero-Cross Detect (ZCD)
- Configurable Logic Cell (CLC)
- Data Signal Modulator (DSM)
- Master Synchronous Serial Port (MSSP)
- Enhanced Universal Synchronous Asynchronous Receiver (EUSART)
- 8-bit Timers
- 16-bit Timers

The implementation of a solar MPPT charger with LED loads system makes use of the following peripherals of PIC16F1779 to achieve optimum performance:
- Analog-to-Digital Converter (ADC)
- Digital-to-Analog Converter (DAC)
- Op amp
- Programmable Ramp Generator (PRG)
- High-Speed Comparator module
- 10-bit Pulse-Width Modulation module (PWM)
- 16-bit Pulse-Width Modulation module
- Complementary Output Generator (COG)
- Data Signal Modulator (DSM)
- 8-bit Timer

When using a DC-DC converter it is essential to have good voltage regulation and transient responses over a wide load current range. Voltage-mode control and current-mode control are the major control strategies. Current-mode control has good dynamic performance and inherent properties, such as short circuit protection. These advantages make current-mode control more suitable for mission-critical applications.

PCMC DC-DC Boost Converter with MPPT

The DC-DC boost converter with PCMC converts the solar panel power to charge the battery and to supply the load. It also includes MPPT.

DESIGN REQUIREMENTS

The design requirements are shown in Table 2 below:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specs</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Input Voltage $V_{IN(nom)}$</td>
<td>17</td>
<td>Vdc</td>
</tr>
<tr>
<td>Maximum Input Voltage $V_{IN(max)}$</td>
<td>21.25</td>
<td>Vdc</td>
</tr>
<tr>
<td>Minimum Input Voltage $V_{IN(min)}$</td>
<td>12</td>
<td>Vdc</td>
</tr>
<tr>
<td>Output Voltage $V_{OUT}$</td>
<td>26.8</td>
<td>Vdc</td>
</tr>
<tr>
<td>Maximum Output Current $I_{OUT(max)}$</td>
<td>4.5</td>
<td>A</td>
</tr>
<tr>
<td>Minimum Output Current $I_{OUT(min)}$</td>
<td>200</td>
<td>mA</td>
</tr>
<tr>
<td>Inductor Ripple Current Ratio</td>
<td>30</td>
<td>%</td>
</tr>
<tr>
<td>Maximum Output Voltage Ripple $\Delta V_{OUT}$</td>
<td>300</td>
<td>mVpp</td>
</tr>
<tr>
<td>Switching Frequency $F_s$</td>
<td>250</td>
<td>kHz</td>
</tr>
<tr>
<td>Estimated Efficiency</td>
<td>&gt; 90</td>
<td>%</td>
</tr>
</tbody>
</table>

For the component selection in boost converter power section, refer to Section Appendix F: “Hardware Design for PCMC Boost Converter”. Coilcraft provides design tools for selection of a power inductor to be used in a DC-DC converter. Select Design Tools ➔ Power Tools ➔ DC-DC Inductor finder. According to calculations the inductor value selected is 15 µH with peak current of 18A and RMS current of 20A. Coilcraft part no. SER2918H-153.
CONTROL SYSTEM DESIGN

Control loop design is a significant part in the design of power converters. It is implemented to ensure stability of the controller. For a high-performance power converter design, the control must be designed for high gain and bandwidth to ensure good regulation and fast response. The output variations due to line or load changes are brought to a minimum using feedback control loop techniques. There are various control techniques that control the duty cycle of the converter. The most popular control technique is Peak Current-Mode Control (PCMC).

The control signals for the boost converter are generated using PCMC. The current-mode control has two feedback loops: the inner current loop and the outer voltage loop. In the voltage loop, the output voltage is compared with a reference voltage. The error is processed by the compensator network to generate the reference signal for the inner current loop. The reference voltage is generated using the DAC peripheral. The compensator is implemented using internal op amp. In the current loop, the reference signal is compared with the measured inductor current. When the inductor current reaches the peak value, the comparator generates a signal and the switch is turned off. The PWM signals for the synchronous DC-DC converter are generated using PWM and the complementary output generator (COG) peripheral. The rising edge and the frequency of the PWM signal is determined using a 10-bit PWM peripheral connected to the COG. The falling edge of the PWM is determined by comparator 1. This generates the required duty cycle to maintain the output voltage within the specified limit. Figure 3 illustrates the Peak Current-Mode Control in a boost converter. The peripherals used in the design can be configured quickly for the required settings using MPLAB Code Configurator (MCC), as shown in Appendix C: “Peripheral Configuration Using MCC”.

FIGURE 3: PCMC DC-DC BOOST CONVERTER WITH MPPT
The plant transfer function in current-mode control is given by Equation 1 below:

**EQUATION 1: PLANT TRANSFER FUNCTION IN PCMC**

\[
f_p(s) = K \cdot \frac{\left(1 + \frac{s}{w_p}\right) \cdot \left(1 - \frac{s}{w_{RHP}}\right)}{\left(1 + \frac{s}{w_p}\right)}
\]

Where

- \( w_p = \frac{2}{RC} \)
- \( w_{RHP} = \frac{R \times (1 - D)^2}{L} \)
- \( R_C \)

And

- \( w_z = \frac{1}{R \cdot C} \)

PCMC suffers from sub-harmonic instability for duty cycles greater than 50%. In this case, the user needs to add a ramp to inductor current for stabilizing oscillations. This is called slope compensation. The ramp can be added to the inductor current voltage image or subtracted from the reference current level. An artificial ramp is subtracted from the reference signal of the comparator and therefore meets the feedback signal at the desired point. The comparator always trips the PWM.

**Slope Compensation using Internal Programmable Ramp Generator (PRG)**

The PRG peripheral of the PIC16F1779 device can be used for the slope compensation to remove the sub-harmonic oscillations.

**PRG Module Configuration:**

1. PRG discharges the internal capacitor quickly at the beginning of the PWM period
2. It charges the capacitor at the programmed rate which determines the slope
3. The capacitor voltage is subtracted from the voltage source to produce ramp decay
4. Voltage source is selected as op amp output (i.e., output of the voltage compensator)
5. The ramp is started by capacitor charging when set rising edge input goes true
6. The ramp is stopped and the capacitor is discharged when set falling edge input goes true
7. For rising and falling edge timing input, PWM can be selected. The ramp can be started at PWM rising edge and stopped at PWM falling edge
8. Set the polarity of rising timing input as active-high. Set the polarity of falling timing input as active-low
9. Slope calculations are described in the following section

To account for sub-cycle oscillations the user needs to add a high-frequency term to the existing power converter transfer function, as shown in Equation 2.

**EQUATION 2: PLANT TRANSFER FUNCTION WITH HF TERM**

\[
f_p'(s) = f_p(s) \times f_h(s)
\]

The high-frequency transfer function is given by Equation 3.

**EQUATION 3: HIGH-FREQUENCY TRANSFER FUNCTION**

\[
f_h(s) = \frac{1}{1 + \frac{s}{w_n} \cdot Q_p + \frac{s^2}{w_n^2}}
\]

The double pole frequency is at half the switching frequency \( T_s \) and is given by Equation 4 below.

**EQUATION 4: DOUBLE POLE FREQUENCY**

\[
w_n = \frac{\pi}{T_s}
\]

The damping factor \( Q_p \) is given by Equation 5.

**EQUATION 5: DAMPING FACTOR QP**

\[
Q_p = \frac{1}{\pi \cdot (m \cdot D - 0.5)}
\]

The compensation ramp factor is given by Equation 6.

**EQUATION 6: COMPENSATION RAMP FACTOR**

\[
m_c = 1 + \frac{S_c}{S_n}
\]
The compensation ramp $s_e$ is given by Equation 7.

**EQUATION 7: COMPENSATION RAMP**

$$s_e = \frac{V_{p-p}}{T_s}$$

The slope of the current waveform is given by Equation 8.

**EQUATION 8: INDUCTOR CURRENT UPSLOPE**

$$S_n = \frac{V_{on} \cdot R_i}{L}$$

The amount of ramp to be added to the system can be calculated by first setting $Q_p$ to 1 and solving the above equations. But the user should add a ramp that is more than half of downslope of the inductor current.

For a boost converter, the downslope of the inductor current is given by Equation 9 below.

**EQUATION 9: INDUCTOR CURRENT DOWNSLOPE**

$$m_2 = \frac{(V_o - V_{in}) \cdot R_i}{L}$$

The criteria for slope compensation is shown in Equation 10.

**EQUATION 10: CRITERIA FOR SLOPE COMPENSATION**

$$S_e \geq \frac{m_2}{2}$$

The ramp compensation is done as shown in Equation 11.

**EQUATION 11: COMPENSATION RAMP CALCULATION**

$$S_e \geq \frac{26.8 - 12}{2} \times 0.25 = 0.1233 V/\mu S$$

**Note:** ISET<4:0> = 0x1 for compensating a ramp slope of 0.25.

---

**The Block Diagram of the Overall Control System***

The small signal block diagram of the power converter for peak current-mode control is given by Figure 4.

**FIGURE 4: BLOCK DIAGRAM FOR POWER CONVERTER FOR PCMC**

Where,

- $\hat{V}_{in}$ = the perturbation of the input voltage
- $\hat{V}_o$ = the perturbation of the output voltage
- $\hat{i}_L$ = the perturbation of the inductor current
- $G_{VD}(s)$ = the control to output transfer function
- $G_{ID}(s)$ = inductor current transfer function
- $f_H(s)$ = sampling gain term
- $R_i$ = sense resistor
- $F_M$ = modulator gain
- $K_F$ and $K_R$ = feed forward and feedback gains
Compensator Design for Peak Current-Mode Control (PCMC)

It is relatively easy to design the current loop in a PCMC power converter, because there is no compensator involved. When the current loop is closed, the control to output transfer function \( G_{VC}(s) \) is given by Equation 12 below.

**EQUATION 12: CONTROL TO OUTPUT TRANSFER FUNCTION**

\[
G_{VC}(s) = \frac{\hat{v}_c}{\hat{v}_o} = \frac{F_m \cdot G_{vd}(s)}{1 + F_m \cdot R_1 \cdot H_c(s) \cdot G_{id}(s) - (F_m \cdot K_r \cdot G_{vd}(s))}
\]

Where,

\[
K_r = \frac{D^2 \cdot T_s \cdot R_1}{2L}
\]

\( G_{id}(s) \) and \( G_{vd}(s) \) for boost converter are given as:

\[
G_{id}(s) = \frac{2V_o}{D \cdot D'} \cdot \left( \frac{1 + \frac{RC}{2} \cdot s}{1 + \frac{L}{2D'} \cdot s + \frac{LC}{D'} \cdot s^2} \right)
\]

\[
G_{vd}(s) = \frac{V_o}{D'} \cdot \left( \frac{1 + \frac{L}{R} \cdot s}{1 + \frac{L}{2D'} \cdot s + \frac{LC}{D'} \cdot s^2} \right)
\]

\( G_{vc}(s) \) can be simplified to a second order system, as shown in **Equation 13**. A current mirror was used in the current design loop. With a current mirror the value of the sense resistor \( R_i \) is given by **Equation 13**.

**EQUATION 13: SIMPLIFIED Gvc(s)**

\[
G_{vc}(s) = \frac{R \cdot (1 - D) \cdot \left( 1 - \frac{s}{w_{RHP}} \right)}{2R_i \cdot \left( 1 + \frac{s}{w_p} \right)}
\]

\[
R_i = \frac{R_2}{R_1} = 0.02 \times \frac{220}{18} = 0.25 \Omega
\]

\[
f_{RHP} = \frac{R \times (1 - D)^2}{2 \pi L_{\text{min}}} = \frac{6 \times (1 - 0.55)^2}{2 \times \pi \times 12 \times 10^{-6}} = 15836.3 \text{ Hz}
\]

\[
w_{RHP} = \frac{f_{RHP}}{2\pi} = 99500 \text{ rad/s}
\]

\[
w_p = \frac{2}{RC} = \frac{2}{6 \times 151 \times 10^{-6}} = 2207.5 \text{ rad/s}
\]

The \( G_{vc}(s) \) of the system for the given specifications is shown in **Equation 14**.

**EQUATION 14: Gvc(s) OF THE SYSTEM**

\[
G_{vc}(s) = \frac{R \cdot (1 - D) \cdot \left( 1 - \frac{s}{w_{RHP}} \right)}{2R_i \cdot \left( 1 + \frac{s}{w_p} \right)} \approx \frac{(5.4 - 5.427 \times 10^{-2} \cdot s)}{(1 + 4.53 \times 10^{-4} \cdot s)}
\]

Once the control-to-output transfer function is calculated, the compensator is designed in such a way that a good bandwidth with a phase margin greater than 45° is obtained. The poles and zeros of the compensator should be placed by analyzing the control-to-output transfer function of the converter. The open-loop bode plot obtained using Scilab is shown in Figure 5 below.

**FIGURE 5: OPEN-LOOP BODE PLOT**

Current-mode control boost converter can be compensated with a type II compensator. A type II compensator has two poles: one at origin and one at zero. The transfer function of a type II compensator is given by **Equation 15**.

**EQUATION 15: TYPE II COMPENSATOR TRANSFER FUNCTION**

\[
H_c(s) = \frac{(1 + R_2 \cdot C_2 \cdot s)}{(R_1 \cdot C_2 \cdot s) \times (1 + R_2 \cdot C_3 \cdot s)}
\]

The poles and zeros of the above transfer function are given by **Equation 16**.

**EQUATION 16: POLES AND ZEROS OF TYPE II COMPENSATOR**

\[
f_{p0} = \frac{1}{2 \pi \cdot R_1 \cdot C_2}, f_{p1} = \frac{1}{2 \pi \cdot R_2 \cdot C_3}, f_{z1} = \frac{1}{2 \pi \cdot R_2 \cdot C_2}
\]
The above transfer function uses the approximation $C_2 \gg C_3$. The pole at zero forms at the integrator section, and it is given $f_{p0}$. $f_{p0}$ needs to be set to get the desired crossover frequency. $f_{p1}$ is usually set at the Equivalent Series Resistance (ESR) zero of the plant. ESR zero is at a higher frequency than the desired crossover frequency. Hence, it is set between $f_{SW}/2$ and $f_{SW}$. $FZ1$ is usually set at the Equivalent Voltage Open-Loop (ESOL) pole of the plant. $FZ1$ is at a higher frequency than the desired crossover frequency. $FZ1$ is set to get the desired crossover frequency. $FZ1$ is usually set at the output pole of the plant. $FZ1$ is usually set at the output pole of the plant. To design the compensator for the converter, follow these steps:

1. Choose the desired crossover frequency $f_C$. Here, the target crossover frequency of the converter is considered as $f_c = 5000$ Hz.
2. $f_{p0}$ is obtained from $f_{p0} = f_c/(A/B)$. A/B is the DC gain of the plant. For the simplified transfer function for PCMC, the DC gain is obtained as shown in Equation 17.

**EQUATION 17: PLANT DC GAIN**

$$\frac{A}{B} = \frac{R \cdot (1 - D)}{2R_i} = \frac{6 \times (1 - 0.55)}{2 \times 0.25} = 5.4$$

As a result,

$$f_{p0} = \frac{f_c}{A/B} = \frac{5000}{5.4} = 925 \approx 1000 \text{ Hz}$$

3. After setting $R_1 = 33 \text{ k}\Omega$ and $f_{p0} = 1000 \text{ Hz}$, $C_2$ will be calculated as shown in Equation 18.

**EQUATION 18: C2 CALCULATION**

$$C_2 = \frac{1}{2\pi \times R_i \times f_{p0}} = \frac{1}{2\pi \times 33 \times 10^3 \times 1000} = 4.82 \text{ nF}$$

The standard value $C_2 = 4.7 \text{ nF}$ will be used.

4. By setting $f_{Z1}$ at $f_p(f_p = 400 \text{ Hz})$, $R_2$ will be as calculated in Equation 19.

**EQUATION 19: R2 CALCULATION**

$$R_2 = \frac{1}{2\pi \times C_2 \times f_{Z1}} = \frac{1}{2\pi \times 4.7 \times 10^{-9} \times 400} = 84.65 \text{ k}\Omega$$

The standard value $R_2 = 100 \text{ k}\Omega$ was used.

5. $C_3$ is calculated by setting $f_{p1}$ at $f_{SW}/2(f_{p1} = 125 \text{ kHz})$, as indicated in Equation 20.

**EQUATION 20: C3 CALCULATION**

$$C_3 = \frac{1}{2\pi \times R_2 \times f_{p1}} = \frac{1}{2\pi \times 100 \times 10^3 \times 125000} = 12.73 \text{ pF}$$

The standard value $C_3 = 12 \text{ pF}$ was used.

The compensator transfer function is computed as shown in Equation 21.

**EQUATION 21: COMPENSATOR TRANSFER FUNCTION**

$$H_c(s) = \frac{(1 + R_2 \cdot C_3 s)}{(R_1 \cdot C_2 s) \times (1 + R_2 \cdot C_3 s)^2} = \frac{(1 + 4.7 \times 10^{-4} s)}{(1.551 \times 10^{-4} + 1.864 \times 10^{-10} s^2)}$$

Once the gain and phase plots of the open-loop transfer function are finalized, the system elements may need to be changed in order to get the best possible bandwidth and phase margin. Usually, the location of the poles and zeros are adjusted to get the optimum gain margin and phase margin.

**MPPT Operation**

The MPPT tracking code is added to the basic output regulation code and battery-charging algorithm. The battery charge system operates in three modes:

- **Constant Current**
- **Constant Voltage**
- **Charge Termination or Float mode**

The MPPT tracking becomes relevant only when battery charge system is in Constant Current or Constant Voltage mode.

During battery charging, the output voltage of the boost converter will be set equal to the desired fully-charged battery voltage. The battery will draw as much current as possible, and the PWM duty will increase. Another comparator is used to limit the PWM duty, and in turn the current delivered by the boost converter. The reference point for the comparator will be set using DAC which determines the current drawn from the solar panel. While tracking the MPP panel, a number of input voltage and current samples are summed together for noise reduction, and then fed to the selected MPPT algorithm. When the required battery voltage is reached and the battery charging current has fallen below C/10, then the Float mode is activated. In this mode the MPPT tracking is not required, as the battery is almost fully charged. Whenever the battery is fully charged, the PWM duty can be set to the minimum value just to float charge the battery and excess power left in the solar panel. If in float charge state the battery voltage falls below a certain threshold, then the Charge mode is activated again. If the panel voltage drops below a certain threshold and/or during night time, when solar power is not available, the PWM control signals going to the boost converter are turned off.
Battery Charge Balancing

Every battery has different discharge/recharge rate when connected in series, even if they have similar properties. This is due to temperature, pressure affecting battery chemistry. If one of the batteries charges faster to full state, it will provide higher impedance to source, thus reducing the current and the rate at which other batteries charge. If these incompletely charged batteries are used, their lifespan may decrease. To solve this problem, battery charge balancing needs to be implemented in circuits where batteries are connected in series.

Because it runs from solar, the user needs to make sure that the battery charging is the most efficient. So there is a need of a charge balancer that does not waste energy like a resistive balancer would. Figure 6 shows the charge balancing circuit.

As part of the charging algorithm, the microcontroller will periodically measure the voltages at VB12 and VB2.

VB1 is calculated by subtracting VB2 from VB12:
1. If VB1 and VB2 are within 50-100 mV of each other, then the system goes back to charging
2. If VB1 is greater than VB2 by 100 mV,
   - CBP1 is driven high
   - CBP1 is driven low when CBIS shows an inductor current in L1 of approximately 1A
   - CBP1 is held off until CBIS shows an inductor current in L1 of approximately 100 mA
   - every 5-10 cycles the voltages need to be checked to make sure they are within 50-100 mV; if they are within range, then go back to charging
3. If VB2 is greater than VB1 by 100 mV,
   - CBP2 is driven high
   - CBP2 is driven low when CBIS shows an inductor current in L1 of approximately 1A
   - CBP2 is held off until CBIS shows an inductor current in L1 of approximately 100 mA
   - every 5-10 cycles check if the voltages are within 50-100 mV, if they are within range, then go back to charging

**FIGURE 6: CHARGE BALANCING**
PCMC DC-DC Buck Converter for 12V/2A Load

Synchronous DC-DC buck converter with PCMC is used for converting the battery power or the boost converter output to 12V for supplying up to 2A current for mobile charging electronics.

DESIGN REQUIREMENTS

The specifications of the buck converter design are shown in Table 3 below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Specs</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Input Voltage $V_{in(nom)}$</td>
<td>24</td>
<td>Vdc</td>
</tr>
<tr>
<td>Maximum Input Voltage $V_{in(max)}$</td>
<td>29</td>
<td>Vdc</td>
</tr>
<tr>
<td>Minimum Input Voltage $V_{in(min)}$</td>
<td>20</td>
<td>Vdc</td>
</tr>
<tr>
<td>Output Voltage $V_{out}$</td>
<td>12</td>
<td>Vdc</td>
</tr>
<tr>
<td>Maximum Output Current $I_{in(max)}$</td>
<td>2</td>
<td>A</td>
</tr>
<tr>
<td>Minimum Output Current $I_{in(min)}$</td>
<td>200</td>
<td>mA</td>
</tr>
<tr>
<td>Inductor Ripple Current Ratio $r$</td>
<td>40</td>
<td>%</td>
</tr>
<tr>
<td>Maximum Output Voltage Ripple $\Delta V_{out}$</td>
<td>200</td>
<td>mVp-p</td>
</tr>
<tr>
<td>Switching Frequency $F_s$</td>
<td>250</td>
<td>kHz</td>
</tr>
<tr>
<td>Estimated Efficiency</td>
<td>&gt; 93</td>
<td>%</td>
</tr>
</tbody>
</table>

For the component selection in boost converter power section, refer to Appendix G: “Hardware Design PCMC Buck Converter 12V/2A”. Coilcraft provides the design tool for selecting a power inductor to be used in the DC-DC converter. Refer to Design Tools → Power Tools → DC-DC Inductor finder.

According to calculations, the inductor value selected is 47 μH with a peak current of 4.6A and RMS current of 4A. Coilcraft part no. MSS1210-473.
Control System Design

Using the feedback control loops the duty cycle of the power switch is controlled so that there will not be any variations in the output voltage. There are various control techniques that control the duty cycle of the converter. The most popular control technique is Peak current-mode control. PCMC DC-DC buck converter is designed using CIPs of PIC16F1779, such as DAC, op amp, PRG, comparator, Timer2, PWM and COG, as shown in Figure 7.

FIGURE 7: PCMC BUCK CONVERTER
Compensator Design for Peak Current-Mode Control Buck Converter

In the current-mode control there are two loops:
• Inner Current Loop
• Outer Voltage Loop

CURRENT LOOP DESIGN

In the control system, the current loop should be designed first. Since there is no compensator in the current loop of a PCMC converter system, the current loop design is relatively simple.

Two issues should be taken into consideration in designing the current loop:
1. The method and gain of the inductor/switch current sensing
2. The slope of the ramp signal for slope compensation

Inductor/switch current sensing is done using a current mirror. With a current mirror the value of the sense resistor \( R_i \) is given by Equation 22.

\[
R_i = R_2 \times \frac{R_4}{10} = 0.05 \times \frac{220}{10} = 1.1 \Omega
\]

SLOPE COMPENSATION CALCULATION

Usually, \( m_c \) (i.e., the slope of the ramp signal to be subtracted from the error amplifier output for elimination of the subharmonic oscillations) is chosen in the range between \( \frac{1}{2} \) of \( m_2 \) (down-slope of the inductor current) and \( m_2 \); but the optimum slope compensation is often found empirically. For a buck converter, the downslope of the inductor current during \( T_{OFF} \) of the switching cycle is given by Equation 23.

\[
m_2 = \frac{V_o \times R_i}{L}
\]

The criteria for slope compensation is:
\[
S_e \geq \frac{m_2}{2}
\]

So compensating ramp will be:
\[
S_e \geq \frac{12 \times 1.1}{2 \times 47} \ V/\mu S

S_e \geq 0.1404 \ V/\mu S
\]

VOLTAGE-LOOP DESIGN

With current-mode control, the inductor of the buck converter becomes a current-controlled source.

In PCMC, the open-loop control to output transfer function of the power plant, \( G_{VC}(s) \), is a combination of three terms: DC gain, a power stage small signal model, and a high-frequency transfer function given by Equation 24.

\[
G_{VC}(s) = G_{DC} \times \frac{\left(1 + \frac{S}{\omega ESR}\right)}{\left(1 + \frac{S}{\omega p}\right)} \times \frac{1}{1 + \frac{S}{\omega n Qp} + \frac{S^2}{\omega_n^2}}
\]

Where,
\[
G_{DC} = \frac{R_{LOAD}}{R_{SENSE}} \times \frac{1}{1 + \frac{R_{LOAD S W}}{\pi L}} = \frac{6}{47} \times \frac{1}{1 + \frac{6 \times 50 \mu}{\pi \times 47 \mu}} = 4.69
\]

\[
a_{ESR} = 2 \pi F_{ESR} = \frac{1}{2 \pi F_{ESRC\ OUT}} = \frac{1}{ESRC_{OUT}}
\]

\[
a_{p} = \frac{1}{R_{LOAD C\ OUT}} = \frac{1}{6 \times 50 \mu} = 3333 \ \text{F} \ \text{P} > \frac{a_{p}}{2 \pi} = 530
\]

\[
a_{n} = \frac{1}{\pi (m_2 \ D' - 0.5)}
\]

In PCMC, the open-loop bode plot of gain and phase is as shown in Figure 8.

FIGURE 8: BODE PLOT OF PCMC PLANT
The PCMC open-loop plant is a single order system. Thus, there is no need of phase boost at desired crossover frequency. Generally, a type II compensator, as shown in Figure 9, will be sufficient for the PCMC system.

**FIGURE 9:** TYPE II VOLTAGE COMPENSATOR

The transfer function of the type II compensator is given by Equation 25.

**EQUATION 25: TYPE II COMPENSATOR TRANSFER FUNCTION**

\[ H(S) = \frac{V_C}{V_{OUT}} = \frac{1 + R_2 C_2 S}{R_a C_2 S (1 + R_2 C_3 S)} \]

The above transfer function uses the approximation \( C_2 >> C_3 \). Where the frequencies of poles and zeros are as shown in Equation 26, below:

**EQUATION 26: POLES AND ZEROS OF COMPENSATOR**

\[ F_{P0} = \frac{1}{2\pi R_a C_2}, \quad F_{P1} = \frac{1}{2\pi R_2 C_3}, \quad F_{Z1} = \frac{1}{2\pi R_2 C_2} \]

There will be an integrator or the pole at origin (i.e., \( F_{P0} \)). The second pole, \( F_{P1} \) of the compensator, can be placed at ESR zero frequency or half the switching frequency, whichever is lower. The zero, \( F_{Z1} \), can be placed at 1/5 of the desired crossover frequency or lesser than that.

The bode plots of type II compensator will be as shown in Figure 10.

**FIGURE 10:** BODE PLOT OF TYPE II COMPENSATOR

The following steps can be used for designing the compensator:

1. Choose the desired crossover frequency \( F_c \).
2. Decide the poles and zeros of the compensator.
   - \( F_{Z1} = 200< F_P \)
   - \( F_{P1} = \) lower of \( F_{ESR} \) or \( F_{SW}/2 = 125000 \)
3. The open-loop gain of the plant at desired crossover frequency can be calculated as shown in Equation 27.

**EQUATION 27: OPEN-LOOP GAIN OF THE PLANT AT DESIRED CROSSOVER FREQUENCY**

\[ G_{F_c} = 20\log_{10}(G_{DC} \cdot \frac{F_p}{F_z}) = 20\log_{10}(1.69 \times \frac{530}{125000}) = -12.7 \, \text{db} \]

4. The compensator should provide gain of \(-G_{F_c}\) (i.e., +12.7 dB) to have gain of 0 dB at \( F_{Z1} \) at \( F_c \).
5. The gain of the compensator at \( F_{Z1} \) is shown in Equation 28.

**EQUATION 28: R2 CALCULATION**

\[ G_{FZ1} = 20\log_{10}(\frac{G_{C0}}{F_{Z1}}) = 20\log_{10}(\frac{1}{2\pi R_a C_2 R_2 C_3}) = 20\log_{10}\frac{R_2}{R_a} = 12.7 \]

Selecting \( R_a = 20 \, K\Omega \), \( R_2 \) can be calculated using:

\[ R_2 = \frac{R_{FZ1 \times 10}}{12.7} = 20K \times \frac{12.7}{20} = 83.6K \]

The standard resistor value is \( 91 \, K\Omega \).
6. $C_2$ can be calculated using Equation 29.

**EQUATION 29: C2 CALCULATION**

$$C_2 = \frac{1}{2 \pi R_2 F_1} = \frac{1}{2 \pi 91K \times 175} = 8.74 \text{ nF}$$

The standard resistor value is $10 \text{ nF}$.

7. $C_3$ can be calculated using Equation 30.

**EQUATION 30: C3 CALCULATION**

$$C_3 = \frac{1}{2 \pi R_3 F_2} = \frac{1}{2 \pi 91K \times 125000} = 9.994 \text{ pF}$$

The standard resistor value is $10 \text{ pF}$.

The combined bode plots of the closed-loop system for the peak current-mode control will be as shown in Figure 11.

**FIGURE 11: BODE PLOT FOR PCMC CLOSED-LOOP SYSTEM**

LED Dimming Engine

If the LED is dimmed by turning its switch mode power supply (SMPS) on/off with a timer-based PWM, a couple of problems may arise. As shown below, when the SMPS is off, the LED discharges the output capacitor giving the LED a slow turn off. When the SMPS is turned back on, the output of the error amplifier is too high because the loop was attempting to increase the output voltage during the off time. The result is that the output voltage is driven too high before the loop can correct.

**FIGURE 12: TIMING DIAGRAM OF LED DIMMING ENGINE**
Therefore, turning on and off the SMPS causes a slow dim out and a bright pulse at the turn on. This appears as scintillation in the light output. To correct the problem, three steps must be implemented in synchronization with the PWM:

1. The LED must be disconnected from the output capacitor to prevent a discharge of the capacitor and a slow dim-out during the dimming off time and then the LED must be reconnected during the dimming on time. This is typically accomplished by a MOSFET on the cathode side of the LED.

2. The time-based trigger of PWM pulses in the COG must be shut down during the dimming off time to prevent overcharging of the output capacitor. During the dimming on time, the time-based trigger must resume. This is typically accomplished by using the DSM to gate the time-based pulses into the COG rising input.

3. The output of the op amp must be tri-stated to prevent changes to the loop filter output during the dimming off time. During the dimming on time, it must be reconnected. This is accomplished by using the output enable override function of the op amp. This disconnects the external loop filter components from the op amp and the PRG.

Figure 13 below shows an example block diagram.

**FIGURE 13: LED DIMMING ENGINE USING PIC16F177X**

The 16-bit PWM is just below the COG. Its output drives Q4 which turns off the LED during the dimming off time. It also tri-states the output of the op amp and it gates the output of the PWM so that during the off time no rising events are sent to the COG.
FIRMWARE

Most of the functionality of the control system is implemented using CIPs of PIC16F1779. This only requires the peripherals' initialization, as afterwards these work independently of the CPU. As the usage of CIPs does not require much CPU intervention, the remaining CPU bandwidth can be used for adding other enhancement features to the design.

MPPT Algorithm

With varying weather conditions, the maximum power point for the solar panel also varies. MPPT controller algorithm will track this maximum power point in any weather condition. As mentioned above, two different algorithms are used for MPPT. A timer is used periodically to interrupt the MCU for MPPT tracking, usually at 10 Hz or less. It measures the input and output power of the system. It changes the current supplied to load and battery charging using PWM to reduce or increase the input current from the solar panel and achieve maximum power point.

A DC-DC boost converter is used to boost input voltage for battery charging and supplying to load, which is also part of an MPPT controller. This DC-DC converter is running at a higher speed than the MPPT tracker. The DC-DC converter acts as load to the MPPT algorithm and simulated ideal load for maximum power point tracking, hence it runs at a higher speed.

FIGURE 14: MPPT FLOWCHART

Note 1: 1. The D is the duty cycle of the PWM for boost converter.
2. The dD is the small increment/decrement factor for duty cycle.
Battery Charging and Charge Balancing

The PIC microcontroller also monitors the battery charging process (i.e., battery voltage using ADC), and provides status information based on battery condition. The battery charging state is also monitored by a battery charge balancing circuit. If there is voltage discrepancy between battery voltages, the charge balancing circuit activates and starts balancing voltage or charge levels of the batteries.

LED Dimming

The dimming level for the LED bulb can be set using two switches SW1 and SW2. For dimming control of the LED1 bulb, both SW1 and SW2 should be pressed for a few seconds. Then SW1 should be pressed again. To increase the brightness press SW2 and SW1 for decreasing it. Similarly, for dimming control of the LED2 bulb, press both SW1 and SW2 for a few seconds, then press SW2. Again, to increase the brightness press SW2 and SW1 for decreasing it.

Monitoring

The system monitors the solar panel output and disables the MPPT boost controller in darkness. The system also monitors the battery voltage while battery health information, such as deep discharge battery, can be communicated to the user. The system monitors the battery charge level at regular intervals, and during battery discharge the remaining battery life information can be communicated to the user using low-power Bluetooth over a cell phone.

Automated Functions for Fault Safety

FAULT DETECTION AND CORRECTION

Short-circuit protection is provided for LED bulbs and the 12V/2A charger output. The output of the DC-DC buck converters is monitored using ADC. In case of a short circuit, the output will go to zero or very low voltage. If the ADC value of the output goes below a set threshold, then the short-circuit condition is detected. Then the DC-DC converter goes in the Auto-shutdown mode and the short-circuit event is communicated to the user. The DC-DC converter remains in Auto-shutdown mode until the short circuit is removed.

Low-Power Bluetooth Communication for Status and Alarm Reporting

The on-board RN4020 is used for communicating the status information and alarms on the Android™ application using the Bluetooth low-energy communication. The RN4020 module communicates via a PIC MCU using UART. The brightness of a particular LED bulb can be controlled with the slider on the Android application. The dimming level can be sent to the system using the Android application and BLE communication.

The status information such as remaining battery charge, panel voltage, panel current and alarms (short circuit in the 12V outputs) can be sent to the user using BLE.

Resource Utilization

Table 4 summarizes the resources used in the solar-based rural electric power system.

| TABLE 4: RESOURCE UTILIZATION |

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Total Available</th>
<th>Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash Memory (Words)</td>
<td>16K</td>
<td></td>
</tr>
<tr>
<td>Data SRAM (Bytes)</td>
<td>2K</td>
<td></td>
</tr>
<tr>
<td>High-Endurance Flash (Bytes)</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>Peripherals</td>
<td>ADC, DAC, FVR, op amp, comparator, PRG, CCP, PWM, COG, ZCD, MSSP, EUSART, Timers, DSM</td>
<td>ADC, DAC, FVR, op amp, comparator, PRG, PWM, COG, 16-bit PWM, EUSART, Timers, DSM</td>
</tr>
</tbody>
</table>
Algorithm

**FIGURE 15: FIRMWARE FLOWCHART**

START

Initialize:
ADC, COMP, DAC, Op-Amp, PWM,
Timers, COG, PRG, 16 bit PWM, DSM

Start timer at 1kHz or higher for settings ADC sampling rate

Timer Expired?

NO

Read V_{Panel}, I_{Panel}, V_{BOOST},
V_{BAT}, V_{BUCK}, V_{L1} and V_{L2} from ADC

MPPT Correction

Yes

NO

MPPT Algorithm

Short CKT

YES

Auto shutdown COG for 250 cycles

Dimming Key Press

YES

LED Dimming

NO

RETURN

**PERFORMANCE DIFFERENTIATORS OF THE DESIGN**

There is a significant number of differentiators in this design that can be attributed to the use of the PIC16F1779 microcontroller. These differentiators are above the basic functionalities that the system is supposed to offer. A few of the more important ones are listed below.

**Simplicity of Circuitry**

Most of the functionalities of the control system are implemented using CIPs of the PIC16F1779 device. The primary factor that leads to the simplicity of this design is that it is possible to control up to four different DC-DC converters with a single PIC MCU, thus eliminating a lot of additional circuitry that a conventional design would need. Using CIPs greatly improves the overall performance and implementation of the system because the use of CIPs do not require much CPU intervention. Hence, the remaining CPU bandwidth can be used for adding other enhancement features to the design. Secondly, the elimination of external hardware components, which are now part of the microcontroller, greatly improves the reliability of the system in terms of avoiding failure of external components due to improper layout, routing and thermal stress. All these factors are already taken care of inside the microcontroller for the CIPs.

The slope compensation is one such example. It is a very important module in case of a PCMC DC-DC converter. There are many advantages to using the internal slope compensation (PRG) of a microcontroller. It requires less device pins to be used in the application. When using external slope compensation circuit, for changing or adjusting the slope of the ramp for particular application, the value of the resistor or the capacitor has to be changed in hardware. But, if using internal slope compensation (PRG), the ramp slope can be changed easily just by changing the register in firmware (i.e., without any hardware change).

**Monitoring**

Various fail-safe and power-saving functionalities can be achieved with this design because of its inherent capability of including monitoring functions in the PIC16F1779 microcontroller. Some important monitoring features are:

- System monitors the solar panel output and it disables the MPPT boost controller in darkness
- System monitors the battery voltage and the battery health information, such as deep discharge battery, and communicates them to the user
• System monitors the battery charge level at regular intervals, and during battery discharge the remaining battery life information can be communicated to the user using low-power Bluetooth over a cell phone.

Control

Controllability of the various sections of this system to yield maximum efficiency, and addition of intelligence to the system are key differentiators from other systems.

• MPPT algorithm is implemented to operate the solar panel at its maximum power
• Battery charge balancing is implemented to increase the battery life
• Battery charging is terminated once batteries are fully charged by disabling the boost converter
• As seen above, LED dimming by turning on and off the SMPS using conventional method causes a slow dim out and a bright pulse at the turn on. This appears as scintillation in the light output. This problem can be easily eliminated by building the LED dimming engine using CIPs such as DSM, COG, 16-bit PWM, op amp, PRG and comparator. This also removes color distortion.

Automated Functions

Automated functions are implemented for fault safety purpose. Fail-safe operation and safety to operating personnel has been given utmost importance in this design. The system is designed to take care of unexpected operation and certain scenarios due to external factors. A few of them are listed below:

• Fault detection and correction: Short circuit protection is provided for LED bulbs and the 12V/2A charger output. If the short circuit condition is detected, the DC-DC converter goes in the Auto-shutdown mode and the short condition is communicated to the user. The DC-DC converter remains in Auto-shutdown mode until the short circuit is removed.
• There is a check for battery presence, and if the batteries are connected in proper polarity.
• For maximizing battery life and improved efficiency, the MPPT is disabled in darkness. The 12V output is disabled when not in use. The LED bulbs are disabled if not in use. The LEDs go in Auto-shutdown mode after three hours with slow dim-out. The auto-shutdown of the LEDs is terminated if any of the dimming control key is pressed.
• If the battery charge is low, then the 12V/2A charger output is disabled, and the LED bulbs are operated in low intensity.

Communications

The low-power Bluetooth connection is provided for status and alarm reporting on mobile phones.

SCALABILITY

The system is designed for a 130W solar panel. The system power can be scaled up by using higher wattage solar panels and a battery with higher AHR rating. 150W is about the maximum that this system should be configured for. For higher wattage the heat dissipation will become problematic. It should be taken into account that the cooling is designed for passive operation.

The system can also be scaled down to have just one, two, or three lighting capability by eliminating 12V/2A output, or by making it identical with output 1 and output 2.

CONCLUSION

This application note provides the design details of a solar MPPT charger for rural electrification systems, and the implementation of it using the intelligent analog and core independent peripherals of a PIC16F1779 microcontroller. The availability of a variety of intelligent analog peripherals, such as Analog-to-Digital Converter (ADC), 5- and 10-bit Digital-to-Analog Converter (DAC), op amp, Analog comparator and Programmable Ramp Generator (PRG) along with core independent 10- and 16-bit Pulse-Width Modulator (PWM) and Complementary Output Generator (COG) make it suitable for power supply applications. As described in the application note, the control system for up to four different DC-DC converters and LED dimming engine can be implemented using a single PIC16F1779 microcontroller.
APPENDIX A: REFERENCES

1. https://etd.auburn.edu/bitstream/handle/10415/328/HE_DAKE_26.pdf;sequence=1
4. Dr. Ray Ridley-Designer’s Series Part V, “Current-Mode Control Modeling”
8. Inductor selector for DC-DC converter from Coil-craft – www.coilcraft.com
9. TB3140, “Programmable Ramp Generator Technical Brief” (DS90003140)
FIGURE B-2: BUCK CONVERTER

Buck Converter 24V to 12V, 500mA

Buck Converter 24V to 12V, 500mA, for LED2

Buck Converter 24V to 12V, 2A
APPENDIX C: PERIPHERAL CONFIGURATION USING MCC

The MPLAB® Code Configurator (MCC) plug-in for MPLAB X can be used to configure the peripherals in PIC® MCUs. The MCC provides Graphical User Interface (GUI) tools to easily understand the configuration and select the required settings. This reduces the time for development. The MCC also provides some built-in functions for working with specific peripherals.

To install MCC, go to Tools → Plugins → Available Plugins → MPLAB X Code Configurator → Install.

To start and use the MCC after installation, go to Tools → Embedded → MPLAB Code Configurator.

Figure C-1 to Figure C-8 show the configuration of the PIC16F1779 device peripherals such as DAC, op amp, PRG, comparator, Timer2, PWM, COG and DSM respectively, used in the implementation of the solar MPPT charger system.

FIGURE C-1: DAC CONFIGURATION IN MCC FOR PIC16F1779

FIGURE C-2: OP AMP CONFIGURATION IN MCC FOR PIC16F1779

FIGURE C-3: PRG CONFIGURATION IN MCC FOR PIC16F1779
FIGURE C-4: COMPARATOR CONFIGURATION IN MCC FOR PIC16F1779

FIGURE C-5: TIMER2 CONFIGURATION IN MCC FOR PIC16F1779
FIGURE C-6: PWM CONFIGURATION IN MCC FOR PIC16F1779

FIGURE C-7: COG CONFIGURATION IN MCC FOR PIC16F1779
FIGURE C-8: DSM CONFIGURATION IN MCC FOR PIC16F1779
APPENDIX D: SOLAR PANEL MANUFACTURERS

1. Tata power solar panel manufacturer in India – www.tatapowersolar.com
2. Moser Baer Solar (Model number 12140P can be used) – www.moserbaersolar.com
3. Akshay solar from India has a variety of solar panels – www.akshayasolar.com
4. Chinese manufacturers of 130W solar panels are listed on the below website – www.made-in-china.com/

APPENDIX E: LOW-POWER BLUETOOTH COMMUNICATION

The system can provide status, via a low-power Bluetooth link.

The status information can be:
• Remaining Battery Charge
• Current Solar Panel Output (voltage/current)
• Current Load (current)
APPENDIX F: HARDWARE DESIGN FOR PCMC BOOST CONVERTER

Selection of Components in the Power Circuit

This section explains the critical parameters to be considered for each of the components in a boost converter, and provides the calculation of the component values based on the design requirements. The choices of components have a significant impact on the converter performance. The selected components are listed in the BOM section along with their manufacturer part number.

For more details about design equations and component selection, refer to AN1207, “Switch Mode Power Supply (SMPS) Topologies (Part II)”.

Inductor Selection

Coilcraft provides design tools for selection of a power inductor to be used in a DC-DC converter. Refer to Design Tools → Power Tools → DC-DC Inductor finder.

While selecting an inductor for the boost converter, the following parameters need to be considered:
- Minimum and Maximum Input Voltage
- Output Voltage
- Switching Frequency
- Maximum Ripple Current
- Duty Cycle

At \( V_{\text{IN(MIN)}} = 12\text{V} \) and \( V_{\text{OUT}} = 26.8\text{V} \), the maximum duty cycle \( D_{\text{MAX}} \) will be calculated as per Equation F-1:

**EQUATION F-1: MAXIMUM DUTY CYCLE**

\[
D_{\text{MAX}} = \frac{V_{\text{OUT}} - V_{\text{IN(MIN)}}}{V_{\text{OUT}}} = \frac{26.8 - 12}{26.8} = 0.5522
\]

For further calculations, the maximum duty cycle is used.

The design and selection of an inductor can influence the choice and the cost for all other components of the converter.

The inductance (L) is calculated as shown in equation Equation F-2.

**EQUATION F-2: INDUCTOR CALCULATION**

\[
L(\mu\text{H}) = \frac{V_o \times D \times (1 - D)^2 \times 10^6}{I_o \times r \times f}
\]

Where,
\[r = \text{ripple current ratio (} r = 0.3 \text{ as per design requirements)}\]

Higher-operating frequency allows the usage of small inductor values. Operating at higher frequencies increases the switching losses in the power MOSFET, thus decreasing the efficiency of the converter.

Choosing the operating frequency should be done accordingly.

For the given specifications, the inductance value is calculated as shown in Equation F-3 below.

**EQUATION F-3: BOOST CONVERTER INDUCTOR CALCULATION**

\[
L(\mu\text{H}) = \frac{26.8 \times 0.55 \times (1 - 0.55)^2 \times 10^6}{4.5 \times 0.3 \times 250000} = 8.844 \mu\text{H}
\]

The root mean square (RMS) inductor current is given by calculations in Equation F-4.

**EQUATION F-4: RMS INDUCTOR CURRENT**

\[
I_{\text{L rms}} = \frac{(V_{\text{OUT}} + V_{\text{SYNCH}}) \times I_{\text{OUT(max)}}}{V_{\text{IN(MIN)}}} = \frac{(26.8 + 0.8) \times 4.5}{12} = 10.354
\]
The ripple inductor current is given by calculations in Equation F-5.

\[ I_{\text{ripple}} = \frac{I_{\text{rms}} \times \text{ripple(ratio)}}{100} = \frac{10.35 \times 2}{100} = 3.105 \text{A} \]

The peak inductor current is given by Equation F-6.

\[ I_{\text{peak}} = \frac{I_{\text{rms}} + \frac{I_{\text{ripple}}}{2}}{2} = 10.35 + \frac{3.105}{2} = 11.9025 \text{A} \]

The inductor chosen is 15 \( \mu \)H with peak current of 18A and RMS current of 20A. Coilcraft part no. SER2918H-153.

**MOSFET Selection**

The selection of the MOSFET for the boost converter must be based on the following parameters:

1. As the MOSFET conducts the inductor current during the ON time, it must have low RDSON to minimize conduction losses and to improve efficiency.
2. The drain current rating of MOSFET should be high, as it carries the peak inductor current.
3. The drain to source voltage rating of the MOSFET should be greater than the output voltage and also have margins for some spikes.
4. The gate charge of the MOSFET should be low in order to decrease switching losses. A high gate charge would mean greater transition times between ON and OFF times of the MOSFET. At higher frequencies it will result in greater conduction losses, thus decreasing the efficiency of the converter.

**Diode Selection**

The selection of the diode for the boost converter is based on the following parameters:

1. The forward voltage drop should be as low as possible to keep the conduction losses to a minimum. The power dissipated in the diode can be calculated as a product of forward voltage drop and load current.
2. The current handling capability should be at least two times the maximum output current.

**Output Capacitor Selection**

The main function of the output capacitor is to provide the load current during the ON time of the switch, and to filter the output voltage ripple. During the ON time, no energy from the input is transferred to the output. Hence, there will be a voltage drop.

The most important parameter to be considered during the selection of the capacitors is the Effective Series Resistance (ESR) of the capacitor. There will also be some drop caused by the Equivalent Series Resistance of the output capacitor. Low ESR capacitors will be required at the output to reduce this ripple. In addition to that, ESR also affects the loop stability requirements.

A parallel network of capacitors can be used at the output, which not only helps in lowering the ESR, but also divides the current ripple. A combination of electrolytic and ceramic capacitors is used at the output.

For the given specifications, the minimum capacitance value is calculated as shown in Equation F-7.

\[ C_{\text{out(min)}} = \frac{I_{\text{out}} \times D}{F_s \times \Delta V_{\text{out}}} = \frac{4.5 \times 0.55}{250000 \times 300 \times 10^{-3}} = 33 \ \mu\text{F} \]

Any capacitance above the calculated minimum value can be used to suit the specifications of the converter. More capacitors can be used in parallel to get a lower ESR, and ensure that the ripple is at its minimum.

**Input Capacitor Selection**

Input capacitors are added to reduce the input voltage ripple. As the ESR is low for ceramic capacitors, they are placed at the input to reduce the ripple.
**Measurement Circuits**

The PCMC methodology employs the peak inductor current as the basic parameter for control. Transistor-based current mirror circuit is used for inductor current measurement, as shown in Figure F-1.

**FIGURE F-1: CURRENT MEASUREMENT USING CURRENT MIRROR**

The voltage corresponding to the current is given by the equation shown in Figure F-1. The current \( I \) represents the inductor current.

\[
V_{\text{sense}} = IR_4 \frac{R_4}{R_1}
\]

For balance \( R_3 = R_4 \)

eg

\begin{align*}
R_2 &= 20 \text{ m\Omega} \\
R_1 &= 20 \Omega \\
R_3 &= R_4 = 200 \Omega \\
V_{\text{sense sensitivity}} &= 200\text{mV/A}
\end{align*}
Selection of Each Component in the Buck Converter Power Circuit

For a buck converter, the external power circuit component selection depends upon parameters like input voltage, output voltage, switching frequency, maximum ripple current and maximum output voltage ripple.

Inductor Selection

The maximum inductor current ripple and the switching frequency determine the size of the inductor. The inductor size is inversely proportional to the switching frequency and the inductor current ripple. Higher-operating frequency allows the use of small inductor values. But operating at higher frequencies increases the switching losses in the power MOSFET, thus decreasing the efficiency of the converter. So the trade-off should be made in the inductor size and switching frequency. As the inductor current ripple increases, the size of the filter capacitor also increases, in order to meet the required output voltage ripple specifications. Generally, the maximum inductor current ripple of 20-40% of the full-load current will be considered. The inductor with less DCR (DC resistance) should be selected to minimize the conduction losses due to the inductor winding resistance.

The minimum inductance to ensure Continuous Conduction mode is given by Equation G-1.

\[
L = \frac{V_{OUT} \times (1 - V_{OUT} / V_{IN})}{A_L \times F_S} = \frac{12 \times (1 - 12/29)}{0.4 \times 2 \times 250000} = 35.17 \mu H
\]

The inductor peak current is given by Equation G-3.

\[
I_{L(Peak)} = I_{OUT} - \frac{A_L}{2} - \frac{40 \% \times I_{OUT}}{2} - 2 \times \frac{0.4 \times 2}{2} = 2.4A
\]

For the specifications given in Table 1, considering \( V_{IN} = V_{IN(max)} \), the inductor value should be (Equation G-2):

\[
L = \frac{V_{OUT} \times (1 - V_{OUT} / V_{IN})}{A_L \times F_S}
\]

Control MOSFET Selection

Control MOSFET will be conducted during the TON period of the switching period. The drain current rating of the MOSFET should be high, as it carries the peak inductor current. Both control and synchronous MOSFETs will be exposed to the input voltage at some point during the switching cycle, so both must have a drain-source breakdown voltage greater than \( V_{IN} \).

There are two types of power losses associated with MOSFETs, switching losses and conduction losses. Switching losses will come up during the turn ON and OFF events of the MOSFET. Conduction loss will appear when the MOSFET is turned on. The total gate charge parameter of the MOSFET will determine the switching losses. The higher the total gate charge is, the greater will be the transition times between the ON and OFF states of the MOSFET. Therefore, at higher frequencies it will result in greater switching losses, thus decreasing the efficiency of the converter. A MOSFET with very low RDSON should be selected to minimize conduction losses and to improve efficiency.

The control MOSFET selected in this design is DMT6016LSS-13, having a drain-source breakdown voltage of 60V, a continuous drain current rating of 9.2A, an RDSON of 18 mΩ, and a total gate charge of 17 nC.
Synchronous MOSFET Selection

Synchronous MOSFET will be conducted during the ToFF period of the switching cycle. Peak current rating and drain-source breakdown voltage of the synchronous MOSFET will be similar to that of control MOSFET.

When the control MOSFET switches off, the voltage at the MOSFET side of the inductor goes negative, thus the voltage across the synchronous MOSFET is nearly zero when the synchronous MOSFET switches on. Therefore, the switching losses of the synchronous MOSFET are negligible, so the total gate charge specification of the synchronous MOSFET is important. Only the RDSON characteristic of the synchronous MOSFET is important.

The synchronous MOSFET selected in this design is the same as the control MOSFET.

Output Capacitor Selection

The output capacitor filters out the ripple content of the inductor current and delivers the stable output voltage to the load. The output capacitor also has to ensure that load steps at the output can be supported before the regulator/feedback control loop is able to react. Low ESR capacitors will be required at the output to reduce ripple in the output voltage. In addition to that, the ESR also affects the feedback control loop stability requirements. There are different types of capacitors available in the market, such as multilayer ceramic, tantalum and aluminum electrolytic. Multilayer ceramic capacitors have lower ESR, and the aluminum electrolytic capacitors have higher ESR. But multilayer ceramic capacitors are available up to 100 µF only. A combination of both electrolytic and multilayer ceramic capacitors can be used at the output to reduce the overall ESR of the parallel combination, and to increase the output capacitance. Capacitors have a high tolerance, usually below its nominal value. Capacitors should be selected based on the following parameters:

- Maximum Voltage
- Maximum Ripple Current
- ESR Ratings at the Temperature
- Frequency of the Application
- De-ratings for DC Bias and Temperature

The capacitance required at the output can be calculated using Equation G-4.

**EQUATION G-4: OUTPUT CAPACITOR BUCK CONVERTER**

\[
C_{OUT(min)} = \frac{I_{OUT} \times D}{F_s \times \Delta V_{OUT}} = \frac{2 \times 12 / 20}{250000 \times 200 \times 10^{-3}} = 24 \mu F
\]

Any capacitance above the calculated minimum value can be used to suit the specifications of the converter. More capacitors can be paralleled-up to get lower ESR, and ensure that the ripple is at its minimum.

The output capacitor selected in this design is a parallel combination of a C3225X7R1E106M250AC (10 µF), a C3225X7R1H105M160AA (1 µF) TDK MLCC capacitor, and a PLV1H390MDL1 (39 µH) aluminum electrolytic capacitor.
Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademarks

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR FNeaks, BeaconThings, BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Hello, JukeBox, KEELOQ, KEELOQ logo, Kleer, LANCheck, LINK MD, maXSylus, maXTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, Optolizer, PIC, picoPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntellIMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2016, Microchip Technology Incorporated, All Rights Reserved.
## Worldwide Sales and Service

### AMERICAS

**Corporate Office**
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277

**Technical Support**
http://www.microchip.com/support

**Web Address**
www.microchip.com

**Atlanta**
Duluth, GA
Tel: 678-957-9614
Fax: 678-957-1455

**Austin, TX**
Tel: 512-257-3370

**Boston**
Westborough, MA
Tel: 512-257-3370
Fax: 774-760-0088

**Chicago**
Itasca, IL
Tel: 630-285-2380
Fax: 630-285-2078

**Dallas**
Addison, TX
Tel: 972-818-6733
Fax: 972-818-6755

**Detroit**
Novi, MI
Tel: 248-848-4000

**Houston, TX**
Tel: 281-894-5980

**Indianapolis**
Noblesville, IN
Tel: 317-773-8323
Fax: 317-773-5453
Tel: 317-536-2380

**Los Angeles**
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608
Tel: 951-273-7800

**Miami**
Tel: 305-577-8600
Fax: 305-577-8601

**New York, NY**
Tel: 631-435-6000

**San Jose, CA**
Tel: 408-735-9110
Tel: 408-436-4270

**Canada - Toronto**
Tel: 905-695-1980
Fax: 905-695-2078

### ASIA/PACIFIC

**Asia Pacific Office**
Suites 3707-14, 37th Floor
Tower 6, The Gateway
Harbour City, Kowloon

**Hong Kong**
Tel: 852-2943-5100
Fax: 852-2401-3431

**Australia - Sydney**
Tel: 61-2-9868-8733
Fax: 61-2-9868-6755

**China**
Tel: 86-10-8569-7000
Tel: 86-10-8528-2104

**China - Beijing**
Tel: 86-10-8569-7000
Fax: 86-10-8528-2104

**China - Chengdu**
Tel: 86-28-8665-5511
Fax: 86-28-8665-7889

**China - Chongqing**
Tel: 86-29-8833-7252
Fax: 86-29-8833-7256

**China - Guangzhou**
Tel: 86-22-3326-8000
Fax: 86-22-3326-8001

**China - Hangzhou**
Tel: 86-20-8755-8029
Fax: 86-20-8755-8030

**China - Hangzhou**
Tel: 86-571-8792-8115
Fax: 86-571-8792-8116

**China - Hong Kong SAR**
Tel: 852-2943-5100
Fax: 852-2401-3431

**China - Nanjing**
Tel: 86-25-3090-4444
Fax: 86-25-3090-4445

**China - Shanghai**
Tel: 86-21-3326-8000
Fax: 86-21-3326-8001

**China - Shenzhen**
Tel: 86-755-8864-2200
Fax: 86-755-8203-1760

**China - Wuhan**
Tel: 86-71-8792-8115
Fax: 86-71-8792-8116

**India**
Tel: 91-11-4160-8631
Fax: 91-11-4160-8632

**Japan**
Tel: 81-3-6152-7160
Fax: 81-3-6152-9310

**Korea**
Tel: 82-2-554-7200
Fax: 82-2-558-5932 or 82-2-558-5934

**Malaysia**
Tel: 60-3-6201-9857
Fax: 60-3-6201-9859

**Philippines**
Tel: 63-2-634-9065
Fax: 63-2-634-9069

**Singapore**
Tel: 65-6334-8870
Fax: 65-6334-8850

**Taiwan - Hsinchu**
Tel: 886-3-5778-366
Fax: 886-3-5770-955

**Taiwan - Kaohsiung**
Tel: 886-7-213-7830

**Taiwan - Taipei**
Tel: 886-2-2508-8600
Fax: 886-2-2508-0102

**Thailand - Bangkok**
Tel: 66-2-694-1351
Fax: 66-2-694-1350

### EUROPE

**Austria - Wels**
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393

**Denmark - Copenhagen**
Tel: 45-4450-2828
Fax: 45-4485-2829

**Finland - Espoo**
Tel: 358-9-4520-820
Fax: 358-9-4520-821

**France - Paris**
Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79

**France - Saint Cloud**
Tel: 33-1-30-60-70-00

**Germany - Garching**
Tel: 49-8931-9700

**Germany - Haan**
Tel: 49-2129-3766400

**Germany - Heilbronn**
Tel: 49-7131-67-3636

**Germany - Karlsruhe**
Tel: 49-721-625370

**Germany - Munich**
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44

**Germany - Rosenheim**
Tel: 49-8031-354-560

**Israel - Ra'anana**
Tel: 972-9-744-7705

**Italy - Milan**
Tel: 39-0331-742611
Fax: 39-0331-66781

**Italy - Padova**
Tel: 39-049-7625286

**Netherlands - Drunen**
Tel: 31-416-690399
Fax: 31-416-690340

**Norway - Trondheim**
Tel: 47-7289-7561

**Poland - Warsaw**
Tel: 48-22-3325737

**Romania - Bucharest**
Tel: 40-21-407-87-50

**Spain - Madrid**
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91

**Sweden - Gothenberg**
Tel: 46-31-704-60-40

**Sweden - Stockholm**
Tel: 46-8-5090-4654

**UK - Wokingham**
Tel: 44-118-921-5800
Fax: 44-118-921-5820